Type 3374 Electric Actuator

Mounting and Operating Instructions

Fig. 1 · Type 3374 Actuator mounted on a Type 3535 Three-way Valve

EB 8331-1 EN
Edition July 2012
Note: Actuators with a CE marking fulfill the requirements of the Directives 94/9/EC and 89/336/EEC. The Declaration of Conformity is available on request.
General safety instructions

For your own safety, follow these instructions concerning the mounting, start-up and operation of the actuator:

- The actuator is to be mounted, started up or operated only by trained and experienced personnel familiar with the product. According to these Mounting and Operating Instructions, trained personnel refers to individuals who are able to judge the work they are assigned to and recognize possible dangers due to their specialized training, their knowledge and experience as well as their knowledge of the applicable standards.

- Any hazards that could be caused by the process medium, the operating pressure, the signal pressure or by moving parts of the control valve are to be prevented by means of the appropriate measures.

- The actuators are designed for use in low-voltage installations. For wiring and maintenance, you are required to observe the relevant safety regulations. The actuator must be protected against unintentional reconnection of the power supply.

- Before wiring the actuator, disconnect it from the power supply.

To avoid damage to any equipment, the following also applies:

- Proper transportation and storage are assumed.
1 Design and principle of operation

The Type 3374 Electric Actuator is used in industrial plants as well as in heating, ventilation and air-conditioning systems. The actuator is suitable for form-fit attachment to various SAMSON valve series, depending on the version with or without fail-safe action. The actuators consist of a reversible synchronous motor and a maintenance-free planetary gear with ball screw. The synchronous motor is switched off by torque-dependent switches when the final positions are reached or in case of an overload.

The motion is transmitted to the actuator stem by the gears and ball screw.

Actuator versions with integrated yoke are primarily used for attachment to Series V2001 Valves, Type 3260 (DN 65 to 150), and Type 3214 (DN 65 to 250) Valves. Actuator versions for central attachment using an M30 x 1.5 ring nut are preferably combined with Series 240 Valves and Type 3214 Valves (DN 125 to 150).

1.1 Additional equipment

The actuators can be equipped with additional units, such as limit contacts and resistance transmitters, to influence the tasks of control equipment. In addition, the actuator can be equipped with a digital positioner for processing standard signals in the range of 0/2 to 10 V or 0/4 to 20 mA.

Refer to section 5 for details on retrofitting additional equipment.
### 1.2 Technical data

<table>
<thead>
<tr>
<th>Actuator Type 3374</th>
<th>-10</th>
<th>-11</th>
<th>-15</th>
<th>-21</th>
<th>-26</th>
<th>-31</th>
<th>-36</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version with</td>
<td>Yoke</td>
<td>Ring nut</td>
<td>Yoke</td>
<td>Ring nut</td>
<td>Yoke</td>
<td>Ring nut</td>
<td></td>
</tr>
<tr>
<td>Fail-safe action</td>
<td>Without</td>
<td>Stem extends</td>
<td>Stem retracts</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rated travel mm</td>
<td>30</td>
<td>15</td>
<td>30</td>
<td>15</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transit time for rated travel s</td>
<td>240/120</td>
<td>120/60</td>
<td>240/120</td>
<td>120/60</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transit time in case of fail-safe action s</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>12</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thrust</td>
<td>2.5 kN</td>
<td>2 kN</td>
<td>0.5 kN</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power supply</td>
<td>207 V to 253 V, 50 Hz · 90 V to 121 V, 60 Hz</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>21.6 V to 27.6 V, 50 Hz</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power consumption VA</td>
<td>Without positioner</td>
<td>7.5/13</td>
<td>10.5/16</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>With positioner</td>
<td>9.5/15</td>
<td>12.5/18</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Motor switch-off</td>
<td>Torque-dependent</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ambient temperature range</td>
<td>5 to 60 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Storage temperature range</td>
<td>-20 to +70 °C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Degree of protection</td>
<td>IP 54 according to EN 60529, (IP 65 with cable glands 1) Suspended mounting position not approved</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overvoltage category</td>
<td>II according to EN 60664</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design and inspection</td>
<td>EN 61010 Edition 3.94</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Class of protection</td>
<td>II according to EN 61140</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Electromagnetic compatibility</td>
<td>According to EN 61000-6-2, EN 61000-6-3 and EN 61326</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manual override</td>
<td>Using hex wrench · Adjustment not possible after fail-safe action has been triggered Manual adjustment of actuators with fail-safe action only possible when power supply is connected (see also section 4.1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Weight, approx. kg</td>
<td>3.2</td>
<td>3.3</td>
<td>3.9</td>
<td>4.0</td>
<td>3.5</td>
<td>3.6</td>
<td></td>
</tr>
<tr>
<td>Materials</td>
<td>Housing and cover made of plastic (PPO glass fiber reinforced)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Additional electrical equipment

- **Limit contact**: Two travel-dependent, adjustable limit contacts, perm. load 250 V AC, 1 A
- **Resistance transmitter**: 0 to 1000 Ω, (0 to 900 Ω at rated travel) max. permissible current 1 mA

---

1) Cable glands M20 x 1.5 with metal nut, width across flats 23/24 mm
2) Not for version with positioner
3) Half the transit time possible for actuators with 50 Hz mains frequency
### Design and principle of operation

#### Digital positioner

<table>
<thead>
<tr>
<th></th>
<th>Operating mode 1</th>
<th>Operating mode 2</th>
<th>Operating mode 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input signal</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Range</strong></td>
<td>4...20 mA, $R_i = 0.05, \text{k}\Omega$</td>
<td>0...20 mA, $R_i = 0.05, \text{k}\Omega$</td>
<td>As per settings $^3$</td>
</tr>
<tr>
<td></td>
<td>2...10 V, $R_i = 10, \text{k}\Omega$</td>
<td>0...10 V, $R_i = 10, \text{k}\Omega$</td>
<td></td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td></td>
<td>10 Bit</td>
<td></td>
</tr>
<tr>
<td><strong>Position feedback signal</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Range</strong></td>
<td>4...20 mA, $R_B \leq 0.2, \text{k}\Omega$</td>
<td>0...20 mA, $R_B \leq 0.2, \text{k}\Omega$</td>
<td>As per settings $^3$</td>
</tr>
<tr>
<td></td>
<td>2...10 V, $R_B \geq 5, \text{k}\Omega$</td>
<td>0...10 V, $R_B \geq 5, \text{k}\Omega$</td>
<td></td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td></td>
<td>8 Bit</td>
<td></td>
</tr>
<tr>
<td><strong>Characteristic</strong></td>
<td>Increasing, actuator stem retracts or extends as the input signal increases</td>
<td></td>
<td>As per settings $^3$</td>
</tr>
<tr>
<td><strong>Travel</strong></td>
<td>Adjustable</td>
<td>6 to 19 mm at 15 mm rated travel</td>
<td>6 to 35 mm at 30 mm rated travel</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Setting</strong></td>
<td>Using travel calibration button</td>
<td>Using travel calibration button</td>
<td>Using travel calibration button</td>
</tr>
<tr>
<td></td>
<td>(1 mm each time the button is pressed)</td>
<td></td>
<td>(1 mm each time the button is pressed)</td>
</tr>
<tr>
<td><strong>1 binary input</strong></td>
<td>Electrically isolated, switching voltage 18 to 30 V DC, approx. 7 mA</td>
<td>Electrically isolated, switching voltage 18 to 30 V DC, approx. 7 mA</td>
<td>Electrically isolated, switching voltage 18 to 30 V DC, approx. 7 mA</td>
</tr>
<tr>
<td><strong>1 binary output</strong></td>
<td>Electrically isolated semiconductor contact, max. 45 V DC, min. 3 V DC, max. 25 mA</td>
<td>Data transmission including settings, operating status and alarms Transfer protocol: SAMSON SSP protocol</td>
<td>Data transmission including settings, operating status and alarms Transfer protocol: SAMSON SSP protocol</td>
</tr>
<tr>
<td><strong>Integrated interface for SAMSON memory pen/PC</strong></td>
<td>Data transmission including settings, operating status and alarms Transfer protocol: SAMSON SSP protocol</td>
<td>Data transmission including settings, operating status and alarms Transfer protocol: SAMSON SSP protocol</td>
<td>Data transmission including settings, operating status and alarms Transfer protocol: SAMSON SSP protocol</td>
</tr>
<tr>
<td><strong>Total delay time</strong></td>
<td>Approx. 30 ms</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Accuracy</strong></td>
<td>$\leq 2.5%$</td>
<td></td>
<td>without taking the dead band into account</td>
</tr>
</tbody>
</table>

$^1$ Maximum two current inputs may be switched in series

$^2$ Maximum values $\pm 50$ mA or $\pm 25$ V

$^3$ SAMSON TROVIS-VIEW Operator Interface software, SAMSON memory pen
2 Installation

2.1 Mounting position

Installation depends on the mounting position of the valve. However, do not install the actuator suspended downwards.

Note: Manual override is only possible in actuators with fail-safe action when the power supply is connected (see section 4.1).

2.2 Attachment to the valve

Series V2001 (DN 15 to 80), Type 3260 Valve (DN 65 to 150) and Type 3214 Valve (DN 65 to 100)

1. Remove protective covers and unscrew nut (6) from the valve.
2. Retract actuator stem slightly using the manual override.
   Place actuator with yoke onto the valve and fasten with the nut (6, SW 36) using a minimum tightening torque of 150 Nm.
3. When the plug stem (5) fits closely onto the actuator stem (3), attach both stem connector clamps (4) and fasten with screws.

Series 240

1. Push plug stem down to close the valve.
2. Turn stem connector nut (8) until a distance of \( x = 75 \) mm (\( x = 90 \) mm for DN 100 and larger) between the top of the yoke and the top of the stem connec-
   tor nut (8) is reached. Secure position with lock nut (9).
3. Place actuator onto valve bonnet (2.3) and fasten with ring nut (7). If necessary, retract actuator stem slightly beforehand using the manual override.
4. When the stem connector nut (8) fits closely onto the actuator stem, attach both stem connector clamps (4) and screw tight.
5. Move actuator stem (3) to the end position (valve closed) using the manual override or motor.
6. Align travel indicator scale (10) to the middle of the stem connector (4) and screw tight.

Type 3214 (DN 125 to 250)

1. Place actuator onto the valve and secure with the ring nut (7). If necessary, retract actuator stem slightly beforehand using the manual override.
2. When the plug stem fits closely onto the actuator stem (3), attach both stem connector clamps (4) and screw tight.
3. Move actuator stem (3) to the end position (valve closed) using the manual override or motor.
4. Align travel indicator scale (10) to the middle of the stem connector (4) and screw tight.
Attachment to Series V2001, Type 3260 (DN 65 to 150) and Type 3214 (DN 65 to 100)

Attachment to Series 240

Attachment to Type 3214 (DN 125 to 250)

Fig. 2 · Attachment to the valve

1 Actuator
2.1 Actuator yoke
2.2 Valve yoke
2.3 Bonnet
3 Actuator stem
4 Stem connector
5 Plug stem
6 Nut
7 Ring nut
8 Stem connector nut
9 Lock nut
10 Travel indicator scale
3 Electrical connections

Upon installation of the electric cables, you are required to observe the regulations concerning low-voltage installations according to DIN VDE 0100 as well as the regulations of your local power supplier.

Establish electrical connections as indicated on the circuit diagram on the actuator cover and as illustrated in Figs. 3 and 4. A maximum of three cable glands can be attached to the housing for cable entries.

Fig. 3 · Terminal connections, version for three-point stepping signal
CAUTION!

- Only connect to the mains power network when the power is switched off.
- Only use power interruption devices which ensure that the power cannot be switched on again unintentionally.
- Particularly for 24 V/50 Hz actuators, use wires with a sufficiently large cross-section to guarantee that the permissible voltage tolerances are not exceeded.

**Fig. 4 · Terminal connections, version with digital positioner**

- Limit contacts (optional)
- Load, max. 25 mA
- Position feedback
- Input
- Binary input active when voltage is applied
- Binary output
- Power supply
- Magnet in version with fail-safe action
4 Operation and setting

4.1 Manual operation of the actuator

To operate the manual override, place a 4 mm hex wrench on the red actuator shaft located at the side of the housing. The hex wrench is included in the scope of delivery. It is attached to the bottom of the housing.

Manual override is only possible in actuators with fail-safe action when the power supply is connected (terminals N and L).

Set the selector switch (2 in Fig. 6) of the actuator with positioner to the operating mode $0 = \square$.

4.2 Setting the additional equipment

To access the additional equipment, unscrew the four fixing screws on the cover using a Pozidrive PZ2 screwdriver to provide enough hold on the screw heads. Take off the cover.

After completing the settings and establishing the electrical connection, refasten the cover. To proceed, place back on the cover and screw the cover screws in slightly to position the cover before tightening them properly.

---

Perform settings while the power is switched on!

4.2.1 Limit contacts

1. Use motor or manual override to move the valve to the position where the switching function is to be activated.

2. Use a hex wrench to turn spindle (2) for the upper limit contact or spindle (3) for the lower limit contact until the associated contact cam on the cam bracket (7) triggers the switch contact of the upper or lower microswitch (1).

4.2.2 Resistance transmitters

The gears of the potentiometers (12) and (13) must be put onto their shafts to correspond with the rated travel of the valve. The rated travel inscription 'Nennhub 15' (or B) or 'Nennhub 30' (or A) must be legible. If this is not the case, pull both potentiometer gears off their shafts and put them back on again with the reverse side of the wheel facing upwards, ensuring they are aligned fairly flush with the potentiometer shaft.

Zero point adjustment

1. Use motor or manual override to move the valve to the desired end position.

2. Place a screwdriver on the slotted potentiometer shaft (12.1 and 13.1).

3. Calibrate resistance transmitter using the connected ohmmeter correspondingly:

   Actuator stem extends: $81/82 = 0 \, \Omega ; \, 91/93 = 0 \, \Omega$

   Actuator stem retracts: $81/83 = 0 \, \Omega ; \, 91/92 = 0 \, \Omega$.
Fig. 5 · Performing settings

1. Microswitch
2. Spindle upwards
3. Spindle downwards
5. Intermediate gear
7. Cam bracket
12. Gear potentiometer 1
12.1. Potentiometer shaft
13. Gear potentiometer 2
13.1. Potentiometer shaft

Torque-dependent switch
Stem retracts

Metal tag

Stem extends

Rated travel inscription
### 4.3 Setting the digital positioner

In the actuator version with digital positioner, the travel is calibrated automatically, allowing the travel (controlled variable $x$) and the input signal (reference variable $w$) of the positioner to be matched in the best possible way. Additionally, the digital positioner provides valve position feedback for remote transmission.

Setting and start-up can be carried out using four different operating modes. Operating modes 1 and 2 work with set data stored in the positioner’s memory. The user only needs to select the operating mode via the selector switch (2) and press the button (4) to start travel calibration.

**Note:** Setup with operating modes 3 and 0 $=\circlearrowleft$ can only be performed using a SAMSON memory pen as the storage medium, or in connection with SAMSON’s TROVIS-VIEW Configuration and Operator Interface software and a PC or bus system. Setup with operating modes 3 and 0 $=\circlearrowleft$ is described in Mounting and Operating Instructions EB 8331-2 EN.

**Settings for operating modes 1 and 2**

Increasing characteristic: actuator stem retracts or extends as the input signal increases.

After the actuator has been mounted on the valve as described in section 2.2 and the electrical connections have been established as described in section 3, proceed as follows:

1. Set selector switch (2) with the arrow pointing to operating mode $0 = \circlearrowleft$ (closed-loop operation switched off).
2. Check mounting position of the potentiometer gear (12).

The gear must be put onto the potentiometer shaft to correspond with the rated travel of the valve. The inscription Nennhub 15 or B (for 6 to 19 mm travel) or Nennhub 30 or A (for 6 to 35 mm travel) must be legible from above on the associated gear side. If this is not the case, pull the gear off the shaft and put it back on again with the reverse side facing upwards, allowing the intermediate gear to engage properly.

**NOTICE**

Actuators with fail-safe action “Actuator stem retracts” or “extends” are only designed for a rated travel of 15 mm. Do not reposition the gear!

---

Make sure that the shaft of the potentiometer (12.1) is adjusted correctly.

3. Switch on power supply and set the input signal to a current $> 4$ mA.
4. Set selector switch (2) with the arrow pointing to operating mode 1 for 4 to 20 mA or 2 to 10 V input and alarm signal, or set it to operating mode 2 for 0 to 20 mA or 0 to 10 V input and alarm signal.
5. Press button (4) to start travel calibration.
Press the button briefly to obtain a travel calibration for valve CLOSED when the actuator stem extends. Direction of action: Increasing/increasing.

Hold the button pressed for longer than three seconds (indicated by switchover from signal lamp 8 to signal lamp 9) to obtain a travel calibration for valve CLOSED when the actuator stem retracts. Direction of action: Increasing/decreasing.

CAUTION!
The automatic travel calibration lasts approximately twice as long as the actuator's transit time. During this period, the valve leaves its current position. Calibrate the travel either on the test bench or when the shut-off valves in the plant are closed.

---

Fig. 6 · Selector switch and position of potentiometer gears in version with digital positioner
After pressing the travel calibration button (4), the actuator stem first moves as far as it will go to the valve’s CLOSED position. Calibration is in progress when both signal lamps (8 and 9) are lit.

Travel calibration starts after the mounting position of the potentiometer gear (12) has been determined automatically. This is indicated by signal lamp (8) for 6 to 35 mm travel and by signal lamp (9) for 6 to 19 mm travel.

When travel calibration starts, the lower signal lamp (9) blinks quickly for about 10 seconds. The actuator stem retracts as far as it will go (maximum travel - valve OPEN).

Travel calibration is successfully completed when the end position is reached. The actuator is in closed-loop operation. The actuator stem moves to the valve position determined by the input signal.

**NOTICE**

If one of the signal lamps starts to blink slowly after the travel calibration button has been pressed and the actuator stem has extended to the valve’s CLOSED position, the potentiometer shaft (12.1) has been wrongly positioned. Remount it manually.

Do not adjust the potentiometer before the closed position is actually reached. This is indicated by the associated, activated switch on the board (Fig. 5 on page 13). To proceed, adjust the shaft of the potentiometer (12.1) by turning it gradually clockwise or counterclockwise with a screwdriver until the signal lamp stops blinking and is constantly illuminated. Turn the screwdriver counterclockwise if the upper signal lamp (8) blinks, and clockwise if the lower signal lamp (9) blinks, corresponding to the icons (7). Travel calibration does not continue until both signal lamps are illuminated at the same time.

**NOTICE**

If both signal lamps start to blink simultaneously during travel calibration, interrupt calibration by pressing the travel calibration button (4) and check the mounting position of the potentiometer gear (12) again. If no travel motion can be determined during calibration, e.g. due to a loose or missing potentiometer gear, both signal lamps blink in alternating sequence. If this is the case, interrupt travel calibration by pressing the button (4), correct the fault, and restart calibration by pressing the button (4) again.
Setting with limited travel range

Travel calibration is usually based on the maximum travel of the valve.

If, however, the maximum possible travel is to be limited to a smaller travel end value, press the button (4) once at the start of calibration while the signal lamp blinks for 10 seconds. As a result, travel calibration via the potentiometer gear with rated travel 15 or 30 is limited to 6 mm. Each time the button is pressed, the travel range is increased by 1 mm.

If, for example, a valve designed for 15 mm is to be operated with a limited travel range of 10 mm, press the button (4) five times during the 10 second time limit. The top signal lamp (8) flashes each time the key is pressed.

Reporting defined events

At the binary output (terminal 83 and 84), predefined events can be indicated (see EB 8331-2 EN) during positioner operation and transmitted to a control room.

5 Retrofitting additional electrical equipment

**CAUTION!**

When installing electrical equipment, make sure the power supply and the signal input are disconnected. Only use power interruption devices which are protected against unintentional reconnection of the power supply.

**Note:** We recommend to apply a small amount of lubricant (e.g. Vaseline) to the spindles on the gear faces and to the sides of the cogs.

The actuator can be subsequently equipped with two limit contacts, two resistance transmitters or a digital positioner.

Depending on the actuator version used, the actuator PCB needs to be replaced as well (see sections 5.2, 5.3 and 5.4).

The actuator version is marked on the nameplate, e.g. Var.-ID 1063729.

When ordering additional electrical equipment from the manufacturer, include this model number in the order.

To install the limit contacts, resistance transmitters or a digital positioner, the basic unit (1400-8829) is required.
Old intermediate plate
The old intermediate plate model is marked with less than six dots. The retrofitting of the additional electrical equipment involves installing the spindle gear and intermediate gear included in the basic unit (1400-8829). The basic unit is not required if a resistance transmitter or a digital positioner is already installed in the actuator.

New intermediate plate (index 6)
The new intermediate plate with index 6 is marked with six dots (••••••). The retrofitting of the additional electrical equipment involves installing all the components included in the basic unit (1400-8829). See Fig. 7 and section 5.1.

5.1 Installing the basic unit with new intermediate plate (index 6)

Note: This section only describes the additional mounting instructions for retrofitting the additional electrical equipment with the new intermediate plate (index 6). First follow the instructions described in sections 5.2, 5.3 or 5.4

5.1.1 Limit contacts
Fig. 8: Place tension spring (14.1) on spindle 4 (4.4), ensuring that the long wire of the spring rests on the spacer (9) and on the intermediate gear (5), while the short wire is located between spindle 3 (4.3) and spindle 4 (4.4). Place the shim (14.2) on spindle 2 (4.2). Then attach the serrated ring (14.3) and push it down as far as it will go. Continue installation following instructions in step 8 on page 20.

5.1.2 Resistance transmitters or digital positioner
Fig. 9: Place tension spring (14.1) on spindle 4 (4.4), ensuring that the long wire of the spring rests on the intermediate gear (5), while the short wire is located between spindle 3 (4.3) and spindle 4 (4.4). Place the shim (14.2) on spindle 2 (4.2). Then attach the serrated ring (14.3) and push it down as far as it will go. Continue installation following instructions in step 4 on page 22 or page 23.
Retrofitting additional electrical equipment

4.1 Spindle 1
4.2 Spindle 2
4.3 Spindle 3
4.4 Spindle 4
5 Intermediate gear
9 Spacer
14.1 Tension spring

Fig. 8 · Installing the limit contacts

4.1 Spindle 1
4.2 Spindle 2
4.3 Spindle 3
4.4 Spindle 4
5 Intermediate gear
14.1 Tension spring
14.2 Shim
14.3 Serrated ring

Fig. 9 · Installing the resistance transmitters or digital positioner
5.2 Limit contacts

The retrofit kit (order no. 1402-0898) is required to install limit contacts.

**Note:** To install the limit contacts, the actuator stem must be in end position, i.e. the stem must be either fully extended or fully retracted. If necessary, move the stem to the appropriate position using the manual override at the side.

1. Remove the fastening screws. Push the actuator board (1) from its guiding to the right. Slightly lift the board and continue pushing it further towards the cable entry.
2. Clip the spindle gear (2) onto the sleeve (3). Make sure the lateral latch is properly engaged in the groove of the sleeve.
3. Plug intermediate gear (5) onto the spindle (4). Place the serrated ring (10) on top and push it down as far as it will go.
4. Plug both ready-assembled contact cams (6) with the cog first onto the cam bracket (7).
5. Push adjustment gears (8) onto their spindles and fasten with one screw each. Check whether the adjustment gears can be turned easily. If not, slightly loosen the screw again.
6. Turn both contact cams (6) as illustrated in Fig. 10.1 corresponding with the position of the actuator stem on the cam bracket (7).
7. Push the spacer (9) onto the spindle for the cam bracket.
8. Push the cam bracket with both cams onto the spindle corresponding with the position of the actuator stem as illustrated in Fig. 10.2. Make sure that the outermost cog of the cam bracket (7) engages in the gearwheel of the intermediate gear (5). In addition, the adjustment gears (8) must engage properly in the corresponding gears of the contact cams (6).
9. Secure the cam bracket (7) and intermediate gear (5) with the serrated ring (10), pushing the ring down as far as it will go.
10. Position the terminal board (11) at the base of the support at a 45° angle (approx.) with the switches facing towards the gears. Push the upper end of the terminal board towards the gears until the board is in a vertical position and properly engaged in the support.
11. Push the actuator board (1) back into its guiding. Make sure that the gears are properly engaged. Fasten the board using screws.

Adjust limit contacts as described in section 4.2.1.

**Note:** At this point, follow the instructions described in section 5.1.1 on page 18 when a new intermediate plate (with index 6) is used.
Retrofitting additional electrical equipment

Fig. 10 · Retrofitting limit contacts, in this example model 3374-11000002000, version with resistance transmitters

1. Actuator board
2. Spindle gear
3. Sleeve
4. Spindle
5. Intermediate gear
6. Contact cam
7. Cam bracket
8. Adjustment gear
9. Spacer
10. Serrated ring
11. Terminal board with microswitches
12. Gear in version with resistance transmitter

10.1 Position of the contact cams (6) on the cam bracket (7)

10.2 Position of the cam bracket (7)
5.3 Resistance transmitters

Actuators with a digital positioner cannot be equipped with resistance transmitters.

To install the resistance transmitters, an actuator board with the appropriate potentiometers and gears (12 and 13) is required.

1. Remove the fastening screws. Push the actuator board (1) from its guiding to the right. Take out the board and replace it with a board with potentiometers.

2. Clip the spindle gear (2) onto the sleeve (3) as illustrated in Fig. 10.1 (top). Make sure the lateral latch is properly engaged in the groove of the sleeve.

3. Plug intermediate gear (5) onto the spindle 1 (4.1). Place the serrated ring (10) on top and push it down as far as it will go.

4. The potentiometer gears (12 and 13) with retaining rings must be put onto their shafts corresponding with the rated travel of the valve. The rated travel inscription 'Nennhub 15' or B (on the upper side with the retaining ring) or 'Nennhub 30' or A (lower side) must be legible from above (also see Figs. 5 and 6).

5. Push the actuator board back into its guiding. Make sure that the gears are properly engaged. Fasten the board using screws.

Adjust the resistance transmitters as described in section 4.2.2.

---

**Note:** At this point, follow the instructions described in section 5.1.2 on page 18 when a new intermediate plate (with index 6) is used.
5.4 Digital positioner

To install a positioner, a corresponding actuator PCB and the TROVIS-VIEW software as well as a connecting cable (1400-7699) are necessary.

**Note:** Actuators with a digital positioner cannot be equipped with resistance transmitters.

1. Remove the fastening screws. Push the actuator board (1) from its guiding to the right. Take out the board and replace it with a board with positioner.
2. Clip the spindle gear (2) onto the sleeve (3) as illustrated at the top of Fig. 12 (top). Make sure the lateral latch is properly engaged in the groove of the sleeve.
3. Plug intermediate gear (5) onto the spindle (4). Place the serrated ring (10) on top and push it down as far as it will go.

**Note:** At this point, follow the instructions described in section 5.1.2 on page 18 when a new intermediate plate (index 6) is used.

4. The gear (12) on the feedback potentiometer, which is equipped with a retaining ring, must be put onto its shaft corresponding with the rated travel of the valve. The rated travel inscription 'Nennhub 15' or B (on the upper side with the retaining ring) or 'Nennhub 30' or A (lower side) must be legible from above (also see Figs. 5 and 6).

5. Push the actuator board (1) back into its guiding. Make sure that the gears are properly engaged. Fasten the board using screws.

5.4.1 Calibrating the positioner

![Fig. 12 · Version with positioner without (top) and with (bottom) limit contacts](image-url)
To calibrate the positioner, proceed as described in section 4 of EB 8331-2 EN.

5.4.2 Simplest method to calibrate the actuator

If tools, such as the TROVIS-VIEW software or a PC, are not available for calibration of the actuator and the actuator operation with maximum precision is not necessary, the simplest calibration method can be performed as follows:

1. Position the selector switch (2) to operating mode 0 = .
2. Press down the travel calibration button (5) for at least 15 seconds until both signal lamps light up.
3. Release the button to start calibration. The actuator stem extends until the torque-dependent switches switch off the actuator. The position of the potentiometer is checked.
4. Re-adjust the potentiometer, if necessary, while observing the signal lamps. Refer to the description given on page 14 of EB 8331-2 EN. After adjusting the potentiometer, the calibration of the actuator is continued.

Mount the actuator on the valve and set the positioner as described in section 4.3 of these instructions.
6 Dimensions in mm

Version with yoke

Version with ring nut

Dimensions in mm:
- 120
- 193
- 294
- 60
- 90 (75)
- 30 (15)
- 204

Stem connector
Type 3374 Electric Actuator
with digital positioner
Setting using TROVIS-VIEW software

Fig. 1 · TROVIS-VIEW Operator Interface for Type 3374 Electric Actuator

Operating Instructions
EB 8331-2 EN

Firmware version 1.3x
Edition July 2012
Modifications of positioner firmware compared to previous version

<table>
<thead>
<tr>
<th>Previous 1.1</th>
<th>New 1.2</th>
</tr>
</thead>
<tbody>
<tr>
<td>In operating modes 1 and 2, travel calibration is also possible when the valve is closed even for versions with retracting actuator stem.</td>
<td></td>
</tr>
<tr>
<td>1.2</td>
<td>1.3x</td>
</tr>
<tr>
<td>On upgrading a positioner or replacing it, an actuator calibration needs to be performed. This is also possible without TROVIS-VIEW software.</td>
<td></td>
</tr>
</tbody>
</table>
1 General

The TROVIS-VIEW software allows various smart SAMSON devices to be configured over a common operator interface. It consists of the operator interface, communication server and the device-specific module. The software has a Windows Explorer® look and feel.

The entire configuration of the digital positioner can be performed over the TROVIS-VIEW Configuration and Operator Interface.

The TROVIS-VIEW software is available in Internet (http://www.samson.de) in Services > Software > TROVIS-VIEW. The software can also be supplied on a CD-ROM on request.

To enable communication with the PC, connect the serial interface to the serial interface (RJ-12 jack) at the actuator using a SAMSON connecting cable.

A hardware package including the connecting cable, memory pen, and modular adapter can be ordered (order no. 1400-7704). The memory pen is also available separately (order no. 1400-7697).

The positioner settings configured in TROVIS-VIEW can be directly transferred over the SAMSON connecting cable to the actuator on site. The transferred data are automatically checked to ensure that are complete and correct.

The travel calibration for the control valve is started by the operator interface. Positioner settings can also be uploaded and displayed in the operator interface.

Fig. 2 · Hardware package
2 Settings in TROVIS-VIEW

2.1 Start-up

Note: Before you set the positioner using the TROVIS-VIEW Operator Interface, you must first mount the actuator onto the valve as described in section 2.2 and establish the electrical connections as described in section 3 of the Mounting and Operating Instructions EB 8331-1 EN.

Refer to the online help [?] for a detailed description of TROVIS-VIEW.

1. Turn the selector switch (2) to operating mode 0 (control switched off).
2. Check if the rated travel indicated on top of the potentiometer gear (12) corresponds with the rated travel of the control valve.

   The inscription for the rated travel ("Nennhub") is 15 (for 6 to 20 mm travel) on one side or 30 (for 6 to 35 mm travel) on the other side of the potentiometer gear.

   If the rated travel indicated on top of the potentiometer gear and hence the mounting position of the gear does not correspond with the rated travel of the control valve, pull the gear off the shaft and put it back on again with the other side facing upward allowing the mating gear to engage properly.

   Make sure that the shaft of the potentiometer (12.1) is not adjusted.

Note!

Actuators with fail-safe action "actuator stem retracts or extends" are only designed for a rated travel of 15 mm. Do not rearrange the gear in this case.

3. Switch on the auxiliary power.
4. Turn the selector switch (2) to operating mode 3.
5. Establish communication between the PC and actuator using the SAMSON connecting cable.
1. Operating mode 1
2. Selector switch
3. Operating mode 2
4. Travel calibration button
5. Operating mode 0
6. Operating mode 3
7. Potentiometer shaft (12.1) clockwise or counterclockwise
8. Signal lamp
9. Signal lamp
10. Actuator stem extends or retracts
11. Jack (serial interface)
12. Potentiometer gear
12.1 Potentiometer shaft

Fig. 3 · Selector switch and mounting position of the potentiometer gear
2.2 Starting TROVIS-VIEW and performing settings

Note!
You can perform the settings in TROVIS-VIEW without the actuator being directly connected, i.e. in offline mode and download the settings later onto the actuator. When online mode is selected, the PC is connected over the software directly to the actuator. Online and offline modes can be switched between in the Device menu or by clicking the icon on the device toolbar.

1. Start TROVIS-VIEW.

To upload the setting data from the actuator onto the operator interface, select Upload from Device in Device menu or click icon on the device toolbar.

2. Click options in the View menu to select or deselect them. When the Trend Viewer is activated, all operating data are uploaded cyclically from the actuator in online mode and displayed in graphs. Right-click the graph to edit the graph or to save it in a file.

3. In Options menu, select Languages to change the interface language. You can switch the language of the interface at anytime while the software is running.
4. Select Communications in Options menu to open the communication window. Click on Port settings button to determine the port.
You can select the COM port manually or start the automatic detection. This function searches through all COM ports (max. 256) of the computer for the device (Type 3374 Actuator) or for the memory pen with 3374 data. The search function is completed when the device or memory pen has been found.

5. Select User level in Device menu in order to be able to enter or alter data. The default setting of Maintenance technician only allows you to read setting data. Expert and Factory calibration requires the user to enter a password (max. 8 characters) which can be altered.
Default password: samson

When necessary:

6. Select Convert in File menu to choose the actuator firmware version. It must match the version specified in the display bar.

7. Select Customer data in Edit menu to enter details on the plant, if required.

8. Select Load Factory Defaults in Edit menu to load default settings onto the operator interface. Any configured data will be overwritten by the default data.
9. Double-click the Operating mode 3 folder in the folder hierarchy.

10. Right-click the Setting subfolder or the Setting row. The current settings of the digital positioner are displayed.

Left-click the corresponding row to select a parameter and double-click it to open the window to modify parameter settings. Right-click the row to open the window to edit the parameter.

More details on the setting parameters are listed in the following table.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input variable</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Lower range</strong></td>
<td>The default values of the lower and upper ranges of the reference variable are 4 and 20 mA. If you, for example, want to connect two or more actuators in parallel to achieve split-range operation, set the lower range of the actuator between 0 and 75 % and the smallest span to 25 %.</td>
</tr>
<tr>
<td><strong>Upper range</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Unit</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Position feedback signal</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Lower range</strong></td>
<td>The position feedback signal is used for remote transmission of the current valve position and is usually the same as the input variable. The lower and upper ranges can be set between 0 and 20 mA or 0 to 10 V.</td>
</tr>
<tr>
<td><strong>Upper range</strong></td>
<td>The direction of action of the feedback signal can be reversed by setting lower range &gt; upper range.</td>
</tr>
<tr>
<td><strong>Unit</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Additional settings</strong></td>
<td></td>
</tr>
<tr>
<td>Priority position (binary input)</td>
<td>The priority position function is activated when the switching voltage exists at the terminals of the binary input. If the priority position function is triggered by an external signal at terminals 81 and 82 during the control operation, the actuator stem moves to the open position (actuator stem retracts) or to the closed position of the valve (actuator stem extends) according to the setting. For a mixing valve, the open and closed positions are reversed accordingly. If no signal exists at the terminals, the normal control operation following the input signal is active.</td>
</tr>
<tr>
<td>Control operation when input variable fails</td>
<td>This function allows you to determine whether the last travel value or the internal reference value (described below) is used for control operation when the input variable fails. This control operation is activated when the input variable falls below 0.5 V or 1 mA.</td>
</tr>
<tr>
<td>Internal reference value</td>
<td>Default setting 50 %, adjustable between 0 and 100 %.</td>
</tr>
<tr>
<td>Binary output</td>
<td>This function is used to determine whether the binary output signal serves as a status monitor, as a monitor for “control switched off” (Fig. 3: Selector switch 2 to Position 0 = [ ] ) or as a limit monitor.</td>
</tr>
</tbody>
</table>
### Settings in TROVIS-VIEW

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switching behavior of limit monitor</td>
<td>The binary output is activated when the value falls below the adjusted minimum limit or exceeds the maximum limit.</td>
</tr>
<tr>
<td>Switching value of limit monitor</td>
<td>The binary output is reset when the value exceeds the minimum limit or falls below the maximum limit plus the adjustable differential gap.</td>
</tr>
<tr>
<td>Limit monitor function: Setting in % in relation to the travel position of the valve.</td>
<td></td>
</tr>
<tr>
<td>Exact final position</td>
<td>When this function is activated, the plug stem moves into its exact final position in the closing phase.</td>
</tr>
<tr>
<td></td>
<td>As soon as the travel position is reached which is closer to the closing position than the current dead band width, the motor is controlled over a constant signal. The current dead band is continuously measured by the actuator and is always smaller than the maximum dead band width.</td>
</tr>
<tr>
<td></td>
<td>The actuator in the closing position is switched off by the limit contacts.</td>
</tr>
<tr>
<td>Maximum dead band width</td>
<td>Adjustable between 1.1 and 5.0 %. A corresponding change in the input signal always leads to a travel movement.</td>
</tr>
<tr>
<td>Travel</td>
<td>(if SAMSON memory pen is used)</td>
</tr>
<tr>
<td></td>
<td>In case the travel range of the control valve is transferred by the SAMSON memory pen, you can set the travel to any value between 6.0 and 35.0 mm.</td>
</tr>
<tr>
<td>Control valve closes when</td>
<td>(if SAMSON memory pen is used)</td>
</tr>
<tr>
<td></td>
<td>This function is used to determine whether the control valve is to close when the actuator stem &quot;extends&quot; or &quot;retracts&quot;.</td>
</tr>
</tbody>
</table>
11. Double-click the Characteristic subfolder and then double-click the Characteristic row in the list to open the Characteristic dialog box.

This dialog box displays the set characteristic and its coordinates.

The default characteristic appears as User-defined and is a linear characteristic defined by two co-ordinates.

Click Point button and select Add to enter coordinates (maximum 11) for a freely configurable characteristic.

Click Characteristic button and select Save to save the new characteristic.

To open default and saved characteristics, select File and Open on clicking the Characteristic button. The files are stored in C:\programme\samson\view3/3374/deu/. The characteristics are saved on installing the TROVIS-VIEW software in the directory "view3...".
12. Select Download to Device in Device menu or click on the device toolbar to download data from the operator interface to the actuator. Click OK to confirm prompted message.

Note: You can reset the data that you have modified to the default setting at any time. To reset the data, select Load Factory Defaults in the Edit menu.

Select Upload from Device in the Device menu or click on the device toolbar to transfer all setting data of the control valve to the operator interface where you can check and modify them, if necessary.

Select Download to Device in the Device menu or click on the device toolbar in order to transfer the modified setting data back to the actuator.

Note that you can activate and deactivate the Additionally Read Factory Setting function by clicking on the Device menu and selecting Additionally Read Factory Setting.

You can print the setting data by selecting Print in the File menu.
2.3 Travel calibration

After downloading all the setting data to the actuator, you can calibrate the travel.

**CAUTION!**
The automatic travel calibration lasts approximately twice as long as the actuator’s transit time. During this, the valve moves out of its present position. Carry out the travel calibration on the test bench or when the shut-off valves in the plant are closed.

1. Select Calibration of Control Valve in Device menu to open the Calibration of Control Valve dialog box.

2. In this box, check either Calibration to Maximum travel range or to Limited travel range and determine whether the control valve closes when the actuator stem retracts or extends.

3. In order to initialize the travel calibration, click Start Calibration button. The progress bar indicates the calibration progress. Read the messages displayed in the status field!

*Note:* If the status field reads “Potentiometer setting is incorrect”, the corresponding signal lamp of the positioner board starts to blink indicating that the potentiometer gear (12) has been wrongly positioned and must be readjusted manually (see Fig. 2).
However, do not alter the potentiometer gear until the closed position is actually reached. You can recognize when the closed position is reached by looking at the associated limit contact located on the board which is activated by the tag (refer to EB 8331-1 EN, Fig. 5). To proceed, use a screwdriver to gradually turn the potentiometer shaft (12.1) clockwise or counterclockwise in accordance with the symbols (7) until the signal lamp stops blinking and is lit constantly.

Turn the screwdriver counterclockwise if the upper signal lamp (8) blinks and turn it clockwise if the lower signal lamp (9) blinks. The travel calibration will not continue until both signal lamps are lit at the same time.

If the status field reads “Mounting position of potentiometer gear is incorrect” during the travel calibration, check if the correct side of the gear is facing upwards.

If there is no travel movement during the calibration (caused by a loose or missing potentiometer gear, for example), the two signal lamps blink alternately. Then, the travel calibration is canceled after a short period of time and the error message “Controlled variable does not change!” is displayed. Click OK, remedy the error and then restart the travel calibration.

If the status field reads “Calibration finished”, the travel has been calibrated successfully. The actuator starts its control operation in response to its reference variable.

4. Close the Calibration of Control Valve dialog box and interrupt communication by disconnecting the SAMSON connecting cable.
3 Additional positioner functions

3.1 Testing

To start the test run, select Test in Device menu and then select Start. Note that you can only perform the test run in one of the operating modes 1, 2 and 3. In order to select one of the operating modes, turn the selector switch (2) of the positioner to the corresponding operating mode.

The test run starts to generate an input variable which increases from the determined lower range (if the input variable corresponds to the lower range value) to the determined upper range at a constant rate. When it reaches the upper range value, it automatically switches over and continuously decreases until it reaches the lower range again and stops the test run.

This continuously changing input signal is transferred from the operator interface to the positioner of the actuator during the test run and causes the control valve to open or close according to the increasing or decreasing signal. The resulting travel position of the control valve, the difference between the input variable and the travel position as well as the current dead band width are continuously transferred from the positioner to the operator interface during the test run and their continuously changing values can be monitored on the operator interface.

The changing values of the input variable (reference variable w) and travel position (controlled variable x) are displayed in a graph. The input variable and the travel position as well as their difference in percent, the current dead band width and the operating mode are displayed numerically. You can determine the rate of change of the input variable by entering a time parameter in the Time slot text box. The time parameter determines the transit time from the lower range to the upper range of the input variable. This parameter should exceed the transit time of the actuator.
3.2 Displaying setting data

In order to display the key setting data of the positioner, double-click the Information folder and then the Display subfolder in the folder hierarchy.

Select Upload from Device in Device menu or click on the device toolbar to upload the current setting data and other information from the positioner and to display them on screen. The displayed data may differ depending on the operating mode selected.

The relation between the input variable and the travel position and the characteristic are displayed in graphs.
3.3 Reporting defined events

In order to display the events which have occurred during the control operation of the positioner, double-click the Information folder and then the Messages subfolder in the folder hierarchy.

Select Upload from Device in Device menu or click 📀 on the device toolbar to upload the current setting data on the operator interface.

Possible defined events:

- Input variable outside of range \( [<0\%;>105\%] \)

- Zero shift [has occurred]
  Initialization if travel > 5 \% and travel rate = 0 mm/s and input variable corresponds to the lower range of the reference variable

- Positioner [cannot calibrate]
  if error > 2 dead band widths and travel rate = 0 mm/s; time-delayed message

- Operating temperature [outside of operating range]
  if temperature < 1 °C or > 64 °C

- Communication [inactive]
  if time-monitored data traffic does not take place

- Control operation [with last travel value; with internal reference value] when input variable fails
4 Factory calibration

The factory calibration comprises the basic setting of the positioner, the travel calibration of the actuator as well as the entering of the serial number and is carried out at the factory.

If necessary, for example, if you have replaced the electronic components, you can also carry out the factory calibration at the place of installation of the actuator. There are two different approaches to calibration:

- Best method to perform the calibration involves using a PC, the TROVIS-VIEW Operator Interface, a current or a voltage source, a sufficiently precise ammeter or voltmeter and a sufficiently precise, mechanical length measuring instrument. This method allows the operation of the actuator with the best precision.
- Simplest method to perform the calibration is possible on site without additional tools such as a PC installed with the TROVIS-VIEW software or the measuring instruments. This method may be used for actuator settings for HVAC applications.

Note: The factory calibration requires that the actuator be isolated from the control valve. The rated travel of the actuator (see nameplate) must be the same as the inscription “Nennhub 15” or “Nennhub 30” printed on the gear that faces upwards. If this is not the case, rearrange the gear as described in section 2.1. After factory calibration is completed, you have to recalibrate the travel of the control valve!
4.1 Calibration using TROVIS-VIEW software

1. Connect the PC to the interface of the positioner using the SAMSON connecting cable. Establish the electrical connection according to the wiring diagram. Switch on voltage supply.

2. Turn the selector switch (2) to operating mode 0=.

3. Start TROVIS-VIEW.

4. Select User level in Device menu. Choose Factory calibration from the drop-down list. Enter the required password “samson” and click OK.

5. Select Upload from Device in Device menu or click on the device toolbar to upload the current setting data onto the operator interface.
4.1.1 Calibrating the input variable

6. Connect an input signal of 0 V.
   Right-click the Input variable row and select Execute to start calibration. After the calibra-
   tion is completed, the setting is saved and indicated by a controller symbol.
   Connect an input signal of 10 V.
   Right-click the Input variable row and select Execute to start calibration. After the calibra-
   tion is completed, the setting is saved and indicated by a controller symbol.

7. An additional calibration of the mA input signal is not absolutely necessary. If this is not
   the case, proceed as described previously for the V input signal.

4.1.2 Calibrating the position feedback signal

8. Calibrate position feedback signal to 0 mA.
   Depending on the existing output signal, right-click the Increase signal or Decrease signal
   row and select Execute.
   As soon as the correct reading is displayed at the measuring device, click Save and select
   Execute.
   After the calibration is completed, the setting is saved and indicated by a controller sym-
   bol.
   Calibrate position feedback signal to 20 mA.
   Right-click the Increase signal row and select Execute until the reading at the measuring
   device is 20 mA.
   Click Save and select Execute. After the calibration is completed, the setting is saved and
   indicated by a controller symbol.

9. Calibrate the position feedback signal 0 and 10 V in the same way as for the mA signal.
4.1.3 Calibrating the actuator

**Actuator stem extends**

10. Right-click _Extend actuator stem_ row and select _Modify_ in the pop-up menu. Right-click _Extend actuator stem_ row again and select _Write_ in the pop-up menu. The actuator stem extends until the limit contact switches off the actuator.

11. Measure the length of the actuator stem up to where the thread of the housing starts and write it down.

12. Right-click _Extend actuator stem_ row and select _Modify_ in the pop-up menu. Select _No_ from the drop-down list for the value in the _Modify Parameter_ dialog box and click OK button to confirm.

![Calibration of actuator](image)

<table>
<thead>
<tr>
<th>Calibration of actuator</th>
<th>Value</th>
<th>Serial number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extend actuator stem</td>
<td>No</td>
<td>serial number</td>
</tr>
<tr>
<td>Retract actuator stem</td>
<td>No</td>
<td>serial number</td>
</tr>
<tr>
<td>Maximum open</td>
<td>123</td>
<td></td>
</tr>
<tr>
<td>Activate actuator stem</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Serial number</td>
<td>234</td>
<td></td>
</tr>
</tbody>
</table>

**Actuator stem retracts**

13. Right-click _Retract actuator stem_ row and select _Modify_ in the pop-up menu. Select _Yes_ from the drop-down list for the value in the _Modify Parameter_ dialog box and click OK button to confirm. Right-click _Retract actuator stem_ row again and select _Write_ in the pop-up menu. The actuator stem extends until the limit contact switches off the actuator.
14. Measure the length of the actuator stem up to where the thread of the housing starts and write it down. The difference between the final positions that you have measured is the maximum operating range of the actuator.

15. Right-click Retract actuator stem row and select Modify in the pop-up menu. Reselect No from the drop-down list for the value in the Modify Parameter dialog box and click OK button to confirm.

**Serial number**

16. Right-click Serial number row and select Modify in the pop-up menu. Enter the serial number from the nameplate for the value in the Modify Parameter dialog box and click OK button to confirm.

**Note:** The actuator cannot be calibrated before the serial number has been entered. If you do not have the serial number, enter a value greater than 0.

**Activate the calibration**

17. Right-click Activate actuator calibration row and select Modify in the pop-up menu. In the pop-up window, enter the values for mains frequency, rated travel and nominal actuating time as written on the nameplate. Enter the maximum operating range of the actuator in mm that you previously measured, however, the value may not be greater than 35 mm.

18. Click Start Calibration button to perform the calibration.
**Note:** If the factory calibration has not been carried out completely, the signal lamp (9) starts to blink. The message that the calibration or the serial number is missing is displayed in the “Calibration has not been carried out completely” section of the Messages subfolder in the Information folder.

19. To exit the calibration parameter, select **User Level** in Device menu and change the user level to **Maintenance technician** or **Expert**.
   Enter the required password (samson) again on selecting **Expert**.

4.2 **Simplest calibration method at the press of a button**

If tools such as the TROVIS-VIEW software, PC etc. are not available for calibration of the actuator and the actuator operation with maximum precision is not necessary, the simplest calibration method can be performed as follows:

1. Position the selector switch (2) to operating mode 0 = ．
2. Press down the travel calibration button (4) for at least 15 seconds until both signal lamps light up.
3. Release the button to start calibration.
   The actuator stem extends until the torque-dependent switches switch off the actuator.
   The position of the potentiometer is checked.

4. Re-adjust the potentiometer, if necessary, while observing the signal lamps. Refer to the description given on page 14.
   After adjusting the potentiometer, the calibration of the actuator is continued.
   On completion of the calibration, the maximum travel is set to 20 mm or 35 mm, depending on the position of the gear.
   The serial number is set to 999 999.

5. Mount the actuator on the valve.

6. Perform the calibration of the control valve.
   You can perform this calibration in TROVIS-VIEW as described in section 2.3 on travel calibration.
   If you do not have this software, proceed as described in section 4.3 on Setting the digital positioner in the Mounting and Operating Instructions EB 8331-1 EN.
5 SAMSON memory pen

The SAMSON memory pen (1400-7697) is able to load and store data in its non-volatile memory and serves as a data carrier to transfer the setting data of the positioner from the TROVIS-VIEW Operator Interface to the actuator and vice versa.

You can select the most relevant functions from the Memory Pen menu such as Upload from Memory Pen, Download to Memory Pen, Modify Memory Pen Status and Interface.

Note that you need a SAMSON modular adapter (1400-7698) to transfer the setting data from the PC to the memory pen and vice versa.

In order to transfer the setting data from the memory pen to the positioner and vice versa, you do not require any adapter because the connector of the memory pen fits the jack of the positioner board. The SAMSON memory pen makes it easy to exchange data with the positioner. The memory pen enables you, for example, to copy the setting data of one positioner to the positioner of another actuator of the same type. You can also download the setting data from a PC or notebook to the memory pen when you are, for example, in your office or at the place of installation of the control valve. Then, you can download this data to the positioner of the corresponding actuator on site. Furthermore, you can archive the setting...
data of the positioner of your actuator in the memory pen. If you have to replace this actuator by a new one, you can download the archived setting data from the memory pen to the new actuator.

Note that the calibration data needed for setting the hardware components of the positioner can only be loaded and transferred using the operator interface and not by means of the SAMSON memory pen. The memory pen can only be used to load and transfer the setting data of the positioner.

If you want to use the memory pen to transfer the setting data to the positioner, for example, first set the selector switch (2, Fig. 2) on the actuator to operating mode 0 and then insert the memory pen into the jack of the actuator. The associated signal lamp (9) starts to blink for about 10 seconds to indicate that communication has been established successfully and that the setting data are being checked.

If the transferred data are considered to be incorrect, corrupt or incompatible, the data transfer is canceled and the signal lamp (9) is not lit continuously. In this case, connect the memory pen to the PC via the adapter, open the Setting folder of the corresponding Operating mode folder and then select Upload from Memory Pen in Memory Pen menu of the TROVIS-VIEW Operator Interface to display and check the data stored in the memory pen.

To activate the control operation with the new setting data, reset the selector switch (2) on the positioner to operating mode 3.

The setting data can only be transferred for operating mode 3. Transferring setting data to the positioner in operating modes 1 or 2 is not possible (exception: unit selection mA/V for input variable and position feedback signal).

Reading the setting data of the positioner is possible for both the memory pen and for the operator interface from every operating mode. All the setting data of the operating modes are usually read.

**Note:** Select Additional settings in the Setting folder to set the travel and closed position of the control valve when using the memory pen.
5.1 Downloading data to the positioner

**Note:** Before you download data from the SAMSON memory pen to the positioner, you must first mount the actuator onto the control valve as described in section 2.2 and establish the electrical connections as described in section 3 of the Mounting and Operating Instructions EB 8331-1 EN.

1. Turn selector switch (2) to operating mode \( 0 = \)
   (control switched off, see Fig. 3 on page 5)
2. Check if the rated travel indicated on top of the potentiometer gear (12.2) corresponds with the rated travel of the control valve.

The inscription for rated travel ("Nennhub") is 15 (for 6 to 20 mm travel) on one side or 30 (for 6 to 35 mm travel) on the other side of the potentiometer gear.

If the rated travel indicated on top of the potentiometer gear and hence the mounting position of the gear (see Fig. 2) does not correspond with the rated travel of the control valve, pull the gear off the shaft and put it back on again with the other side facing upward, allowing the mating gear to engage properly.

Make sure that the shaft of the potentiometer (12) is not altered.

**Note:** Actuators with fail-safe action "actuator stem retracts or extends" are only designed for rated travel 15 mm. Do not rearrange the gear in this case.

3. Switch on auxiliary power.
4. Plug the SAMSON memory pen into the jack (11) of the positioner board and wait until the signal lamp (9) stops blinking and remains illuminated.
5. If you want to use the travel value and the closed position of the control valve indicated in Additional settings of the Setting subfolder, initialize the travel calibration by activating the travel calibration button (4).

If, however, this is not the case, disconnect the memory pen from the jack, set the selector switch (2) to operating mode \( 3 \) and perform the travel calibration according to section 4.3 of the Mounting and Operating Instructions EB 8331-1 EN.
CAUTION!
The automatic travel calibration lasts approximately twice as long as the actuator’s transit time. During this, the valve moves out of its present position. Perform the travel calibration on the test bench or when the shut-off valves in the plant are closed.

After activating the travel calibration button (4), both signal lamps (8 and 9) remain illuminated at the same time to indicate the beginning of the travel calibration. The actuator stem extends as far as the closed position of the valve.
The mounting position of the potentiometer gear (12.2) is determined automatically and signaled by the illumination of the signal lamp (8) for 6 to 35 mm travel and the signal lamp (9) for 6 to 20 mm travel.
The actuator stem retracts as far as the open position (maximum travel). When the maximum travel position is reached, the travel calibration has been completed. The actuator starts its control operation and the actuator stem moves to the valve position determined by the reference variable.

CAUTION!
If one signal lamp starts to blink slowly after the travel calibration button has been activated and the actuator stem has extended as far as the closed position, the potentiometer (12) has been wrongly positioned and must be readjusted manually.
However, do not alter the potentiometer until the closed position is actually reached. The closed position is indicated by the associated limit contact located on the board and activated by the tag. To proceed, use a screwdriver to turn the shaft of the potentiometer gradually clockwise or counterclockwise until the signal lamp stops blinking and remains illuminated. Turn the screwdriver counterclockwise in accordance with the symbols (7) if the upper signal lamp (8) blinks and turn it clockwise if the lower signal lamp (9) blinks.
The travel calibration does not continue until both signal lamps are lit at the same time.

Note: If both signal lamps start to blink at the same time during the travel calibration, disconnect the memory pen from the jack and cancel the calibration by pressing the travel calibration button.
Recheck the mounting position of the potentiometer gear (12.2) and/or the travel value indicated in Additional settings of the Setting folder.
If there is no travel movement during the calibration (due to a loose or missing potentiometer gear, for example), both signal lamps blink in alternating sequence. In this case, cancel the travel calibration by pressing the travel calibration button (4), remedy the error and restart the calibration by pressing the travel calibration button (4) again.
6. Disconnect the memory pen from the jack.
7. Set the selector switch (2) to operating mode 3.

**Note:** The travel calibration only needs to be performed once to start up the valve.

5.2 Uploading data to the memory pen

1. Plug the SAMSON memory pen into the jack of the positioner board and wait until the signal lamp (9) stops blinking and is then lit continuously.

2. Disconnect the SAMSON memory pen from the jack (11).

The setting data of the positioner is stored in the memory pen and can be transferred to other actuators or can be downloaded to the PC.

**Note:** You can only transfer the setting data from the positioner to the SAMSON memory pen if you have selected one of the operating modes 1, 2 or 3!